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Shhhhh! Be varwy varwy quiet! But the 3.2.18­x
kernel has made its way to the regular repos.
Without any fanfare, and without any
announcement, the 3.2.18­x kernel has been freed
from the testing repos. Remember that your kernel is
not updated as part of your routine and regular
updates. Instead, you will need to specifically install
it from Synaptic. The new kernel will be installed
right next to your currently installed kernel, allowing
you an easy route to revert back to your old kernel,

should the new kernel have some issues with your
hardware. Also, remember that the first time you
boot your computer with your newly installed kernel
will take a little extra time, as all the modules and
drivers are rebuilt for your new kernel.
If you are fearful about updating to the new kernel –
don’t be. So far, I’ve updated three of my computers
to the new kernel and everything has gone just fine,
except for a minor issue with a wireless adapter no

longer able to connect using WEP. I had been
meaning to change from WEP to WPA­PSK for
some time now, and the situation just got me off of
my duff and forced me to stop procrastinating.
Do you have to update your kernel? In one word,
nope. If the 2.8.38 kernel is performing well for you,
then you can continue using it. Remember that
kernel updates are not a part of your regular and
routine updates. Eventually, you will want to – and
may even have to – update to the newer kernels.
But for the moment, you can continue using your
current kernel.
In other news … you may have noticed that The
PCLinuxOS Magazine now comes in two new
“flavors.” As if he hasn’t done enough for the
magazine by providing the magazine’s new web
server, David Moore (a.k.a. YouCanToo) has
undertaken the chore of converting the monthly
magazine issues into *.epub and *.mobi ebook
editions. These ebook editions now make it easy to
view The PCLinuxOS Magazine on your B&N Nook,
Amazon Kindle, and most other modern ebook
readers on the market. YouCanToo will be creating
ebook editions of all the magazine’s 2012 issues, so
keep an eye on the magazine’s website to grab your
copies when they become available.
Also, Leiche has released a new, updated 2012.06
version of the LXDE Live CD. Of course, if you’ve
kept your installation regularly updated, you already
have the “latest” version of LXDE. Still, if you are
planning to install LXDE on a friend’s computer in
the near future, you may want to download and use
the updated LXDE Live CD. It’ll help streamline the
installation and update process.
Until next month, I wish each and every one of you
peace, happiness, serenity and prosperity.

Welcome From The Chief Editor
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by Meemaw
I’ve been using GIMP since I started using Linux.
While I can do most of what I want to do fairly easily,
GIMP contains many options that I haven’t used
much. In these articles, I will try to explain a little
about GIMP and how to use it.
GIMP, of course, stands for Gnu Image Manipulation
Program. The website is http://www.gimp.org/. It
can be found in most any distro’s repository and
PCLinuxOS is no exception. It can also be installed
in Mac and Windows, so I use it at work in Win7, as
well as at home with PCLinuxOS.
When you open it, you are shown three windows as
shown below:

While many of our graphics programs are displayed
all in one window, Gimp has had them separate for
years. GIMP 2.8 has been released now. It has a
single window display, but has the option of leaving
the windows separate. I really like the separate
windows, because I can arrange the them the way I
want them. However, it hasn’t made it to our repos
yet, so be patient – GIMP 2.6 works very well.
The window on the left of the screen is your main
toolbox. The tools there are the ones you will use
the most. For each tool, there is a corresponding
config section, so the bottom of that window will
change depending on the tool chosen at the top.
The area at the top of the toolbox (where you see
Wilber, the Gimp critter’s eyes and nose) is the Drop

Target area. If you have a file manager open too,
you can drag the item you want to work on to this
area and it will open in Gimp.

Going across the rows in
order, the tools are as
follows:
Rectangle Select ­ You
can designate a
rectangular area and
manipulate it.
Elliptical Select ­ Create
a circular or elliptical area
and manipulate it.
Freehand Select ­ Create
an irregular­shaped area
by clicking your mouse
along the outside of the
area. Very handy!

Continuous Region Select ­ This selects
connected areas.
Color Select ­ Selects areas of similar color.
Intelligent Scissors (Select from image) ­ Selects
along an edge ….
Foreground Select ­ You can use this for cutting
items out of photographs... complicated tool.
Path Tool ­ You can use this to create a path, which
you can then edit
Color Picker ­ If you want to exactly duplicate a
color in a picture, choose this tool and click on the
color. You can use the selected color to edit your
drawing.
Zoom ­ You can see your work close­up with the
Zoom tool.
Measure Tool ­ Measures distances in your
drawing.
Move Tool ­ Click on this to move your object into
place.

Graphics Tutorials: GIMP, Part 1

http://www.gimp.org/
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Align ­ You can choose 2 or more objects or layers
and align them
Crop ­ You can crop an image. Click and drag for
your area, then press enter to crop.
Rotate ­ Clicking on this tool will let you rotate your
object.
Scale ­ To resize your drawing or object
Shear ­ To skew an object. (Example: You can
change a square to a diamond.)
Perspective ­ You can apply perspective to a 2
dimensional image to make it look more 3D.
Flip ­ Used to flip your object horizontally or
vertically
Text Tool ­ To add text to your creation
Bucket Fill ­ To add one color to a large area
Gradient Fill ­ To create a gradient in your object
Pencil ­ Draws thin lines, like a pencil line, but not
smooth. Works better for very small objects where
the pixels have to be in exactly the right spot.
Paintbrush ­ This tool draws smoother lines than
the pencil, and this is probably the most used tool.
Eraser ­ Erases the color from your image. Actually,
it changes whatever you stroke to transparency, so it
can also be used as a paint tool.
Airbrush ­ Paints like an airbrush, using a spray or
fuzzy effect rather than a solid line.
Ink Tool ­ Draws lines more like a calligraphy pen.
Clone Tool ­ Use this to clone parts of an image.
Healing Tool ­ This will heal small blemishes in
photos.
Perspective Clone ­ Advanced tool for cloning
something into the image which may not look as it
looks now (like cloning a face so it looks like it’s a
picture on the wall).
Blur/Sharpen ­ Softens or sharpens colored edges
and blends colors together.
Smudge ­ Drawing with this through two colors will
cause the colors to blend, although maybe not the
way you want.
Dodge/Burn ­ Can make an area darker or lighter.

The window on the right contains the Layers,
Channels, Paths and Undo tools, and we will use
that as well, but I will cover it separately, in an
upcoming article.
OK, let’s experiment. Your center window contains
all your menus (and all of your tools can be
accessed from here as well). Click on File > New.
You will see a window for a new image. Here you
should designate the size of your image, and in
Advanced Options, whether the background should
be white, black or transparent. I clicked on the
dropdown and selected 800 px x 600 px, then
opened the Advanced Options and selected white,
and clicked OK.
Select either the paintbrush or pencil, and draw a
circle. Play with it a little bit just to get the feel of the
tool. It doesn’t have to be a perfect circle.

Playing more with your brush
tool, make a face on your
circle. Since some of us
aren’t artists (myself
included!), your face will look
different from mine. Getting
the feel of the tool, you can
make several strokes. If you
make one you don’t like, you

can go to Edit > Undo, or press <CTRL> + <Z> to
remove the stroke. If you use the keystroke CTRL­Z,
you can hold down CTRL and press the Z as many
times as you wish to remove as many strokes as you
need.

Sooner or later you’ll have to
save your file. Just as with
other programs, go to File >
Save as... and name your
file, then designate a
location in which to save it
so you can find it again. The
default file format for Gimp is
.xcf, which is designed to
save all your layers while

you are working on your creation. You can save your
finished product as any number of image types,
such as *.jpg or *.png.
Lets add some color to our drawing. From the
toolbox, you will see a color swatch (the black &
white rectangles underneath the tools). Click on the
swatch and the Edit Foreground or Edit Background
color window will open. From here you can choose
whatever color you want to use. The default
foreground color is black and the default background
color is white.

You will have several tabs in your window (top left
corner). On the first tab, you will see the default color
square (probably in shades of red & black) with a
rainbow­colored vertical bar to the right of it. To the
right of that you will see six horizontal bars of color
with letters next to them. Those letters are for the
following words, which are color settings you can
adjust:
Hue: This is the color you want. You should
probably click it in the vertical bar first, then all the
other settings will display the color you are working
with.
Saturation: This is how pale a color is (I think of it
as how much of the color used). The slider will make
it more or less intense.

Graphics Tutorials: GIMP, Part 1
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Value: I think of this as how light or dark a color is,
but Gimp’s glossary says it is how much light is
emitted by a color.
Red, Blue & Green: These are the colors that will
be mixed for everything you do. Each individual
slider can be adjusted separately to produce just the
right color. To the right of each slider is a blank
containing a number. Each color can be described
with a series of numbers from 0 to 255 (0,0,0 is
black and 255,255,255 is white. All other colors are
in between.) If you have the numerical code for the
perfect color, you can adjust the numbers in these
blanks. If you are deciding on a color, each slider
can be adjusted individually.
In addition, all colors can also be described with a 6­
digit hexidecimal code. (000000 is black and ffffff is
white. One shade of purple is 430da9.) If you know
the code for your perfect color, you can enter it in
the space provided in this window. (Also called
HTML notation)
One of the tabs will have a printer on it and be the
CYMK, referring to the printer colors Cyan, Magenta,
Yellow & Black. This is not really supported in Gimp
so they don’t describe it much, but it is apparently to
adjust your colors according to the cartridge colors
of your printer. That would have been a great idea
with one of my older printers ­ it printed everything
several shades too dark.
One tab will have a paintbrush on it and it is the
Watercolor wheel. It gives you a color square and
you click the color you want. The more times you
click, the more intense the color will be.
One tab will have the “color wheel” on it (also called
the Triangle Selector). It is the multi­colored circle
around a multi­colored triangle. Click the color (Hue)
you want in the circle, then drag the white ring into
the interior of the triangle to adjust Saturation and
Value.

The Palette tab will have a grid of the colors
contained in the color palette being used by Gimp.
You can choose one of those, and go back to the
first tab and edit your color there.
I use the first tab and the color wheel the most. Click
on the vertical bar between yellow and orange.
Looking at the horizontal bars to the right, you can
adjust your color until it is an approximate skin tone,
whatever color you want to make the face. The color
will show in a bar underneath the color square or
wheel. You can keep adjusting until you get it just
right. There are also small swatches that will save up
a record of the last 12 colors you used. Click OK,
then choose the Bucket Fill tool and click inside your
face. Your drawing should now have a skin­tone
color in it. If you don’t like the color after all, press
your <CTRL> + <Z> to undo it, then go to your color
window and adjust your color again.

NOTE: The Undo function keeps track of everything
you do so you can click undo over and over to
remove lots of things. HOWEVER, once you save
your drawing, all the undo history is gone, so make
sure it is the way you want it before you save it and
close down Gimp.
Play with this a little, and have some fun! Next
month we’ll learn more about the interface and then
add more to our drawing.

International CommunityPCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

Brazil

Graphics Tutorials: GIMP, Part 1

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
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longtom comes from a long line
of distinguished animal trainers How longtom sees himself

longtom practicing
with BubbaBlues

How his animals see longtom

~ longtom and longtomjr ~Proud members of the Forumlongtom ­­ exhaustedfrom signing autographs

Forum Foibles:Featuring Family Foibler longtom
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the Gimp Tree brush, I added
a colorful autumn tree to the
foreground. I simply created a
new layer, sized the brush,
picked the color, and clicked. I
overlaid an additional color
(with the exact brush and size)
and offset just a bit to create a
blur as if the tree were out of
focus in the foreground. I also
applied a bit of transparency to
this second added layer. So,
get some brushes from the
repo and get creative!

Mark's Quick Gimp Tip

­Mark Szorady is a nationally
syndicated cartoonist with
georgetoon.com. He blogs at
georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

In previous articles, I've
written about adding filters
and brushes to Gimp from
third parties. But, it needs to
be pointed out that
PCLinuxOS has many Gimp tools already
available in its repository. Just launch the
repository, reload, and search for “Gimp.”
within the returned results you'll find a
number of filters and brushes. That install
with one click. I added the Trees brush.
This brush gives you a variety of tree
shapes that you can use to add some fun to
your photos. For instance, check out the
two photos below. (The image is a free
wallpaper I obtained from my Alma mater's
website, The Ohio State University). Using

Answers on Page 10

Mark's Quick Gimp Tip & Double Take

www.gimp.org
www.gimp.org
www.georgetoon.com
www.georgetoon.com/blog
mailto:georgetoon@gmail.com
http://www.osu.edu/download/images.php
www.pclinuxos.com
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by AndrzejL

Several months ago, there was a “demand” from
PCLinuxOS devs to install and run the aptupgrade
package. This was a crucial package. Everywhere
on the forum, there were reminders about doing this.
Why was it so important? Because it was upgrading
apt, rpm and their libraries. Also, Synaptic Package
Manager was upgraded.
Whoever did not upgrade it in time (they had a few
months’ window) should reinstall with a fresh copy of
the latest iso after creating a list of all the installed
apps and backing up their /home folder. Why?
Because the packages created using the latest rpm
would not be compatible with the systems that were
not upgraded.
That was the suggested solution. Reinstall. BUT
what if you do not want to or cannot install from
scratch due to many personal tweaks and/or for any
other valid reasons?

If you are desperate/brave/crazy enough (like me)
and you are willing to take some risks (like me) –
please continue reading. I don’t have to tell you that
I won’t take any responsibility for a borked system
right? Right.
Recently, I visited a friend who is dual­booting
Windows XP and PCLinuxOS. I tried to install
gparted, and noticed he had not upgraded his lappy
for 10 months or so. I tried to upgrade it, but all I got
was librpm dependency problems – no matter what
I did. So, I said right – aptupgrade was not done.
So here is (more or less) what I did to fix it. (I am
skipping all the investigation steps).
Open a terminal and run:
su
followed by
root's password
and then…
cd /root/
wget ­c http://andrzejl.cyryl.net/WoTW/WoTW_files/aptupgrade/aptupgrade­1.0­7pclos2011.src.rpm
rpm ­ivh /root/aptupgrade­1.0­7pclos2011.src.rpm
unxz /root/rpmbuild/SOURCES/ aptupgrade­1.0.tar.xz
cd /root/rpmbuild/SOURCES
tar xvf ./aptupgrade­1.0.tarcd ./aptupgrade­1.0

rpm ­ivh ­­nodeps ­­force ­­ignorearch ­­ignoresize ­­ignoreos ./*.rpm
rm ­f /root/aptupgrade­1.0­7pclos2011.src.rpm
rm ­Rf /root/rpmbuild/
BE CAREFUL WHILE USING THE RPM
COMMANDS!
Now, leave this terminal window open and follow this
very important step.
Open Synaptic. When it reloads, you will get three or
four errors (in one error window) about multiple
versions of packages (like apt, libapt and synaptic)
being installed. Write down the names of these
packages and click on OK to clear the message
from your screen. Now search for those packages in
Synaptic. You will find that indeed there are multiple
versions installed. Compare their version numbers
and “Mark for complete removal” the older versions.
Apply the changes. Wait for the packages to be
removed and Synaptic to reload. Close and reopen
Synaptic. There may be another message about

Forgot To Run aptupgrade? Don't Panic!

http://www.pclinuxos.com/forum/index.php/topic,103817.0.html
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duplicate packages. Write down their names, find
them, mark the older versions for complete removal,
apply, wait till finished, close and reopen Synaptic.
Repeat till there are no duplicate packages error
messages when starting Synaptic. I guess this could
be done by using dupeclean package but I did it by
hand just to make sure nothing really important
would get removed when dealing with duplicates.
When this is done close Synaptic.
Now go back to that terminal window that you had
open and type in:
apt­get update
and when done
apt­get dist­upgrade
Wait for the question about
installing/upgrading/removing etc., etc., etc. Read,
understand and if all is ok – confirm by pressing y,
followed by Enter.
Wait until it finishes and reboot. Why not use
Synaptic to do the upgrade? Because I was afraid
that replacing/upgrading so many crucial system
libraries after such a long time of not upgrading the
system at all could crash synaptic in the middle of
the upgrade and could cause system­wide
corruptions and multiple problems.
On a side note, at my friends house I recently got
937 packages to be upgraded, 36 new to be
installed and 33 to be removed. Over 1080 MB of
upgrades. After upgrading and rebooting, the system
worked perfectly without the tiniest issue. Even
funnier was that I forgot that I had testing section
enabled and upgraded fully with it enabled. I said to
myself to bite the bullet and upgraded his kernel to
the testing version as well. Kernel 3.2.16­bfs was
installed without the tiniest hiccup.
So did you fully reboot? Check for updates using
Synaptic as you normally would. In the future, don’t

forget to upgrade at least every 2 weeks and
periodically check the forum for any important
announcements for your distro.

Screenshot ShowcaseScreenshot Showcase

Answers to Mark Szorady's Double Take:
(1) “OF” smaller; (2) Ant's antenna shorter; (3) Ant's
hand holding rocket; (4) Hat moved; (5) Rocket
added; (6) Bug's nose shorter; (7) Cloud moved

Posted by gandy, June 1, 2012, running KDE4.

Forgot To Run aptupgrade? Don't Panic!

http://www.linuxfoundation.org/
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by Paul Arnote (parnote)

After spending some time on the web, there are
many users who may wish to create their own
personal web page. There are many ways to do it.
First, you can use a web interface to create a bare
bones web page. Some web interfaces at least allow
you a few customization options, like different
backgrounds, text sizes, layouts, etc. But they all
look like “cookie cutter” pages with their similar
appearance.
Second, you can create a personal blog. Most of
these use a web interface to allow the blogger to
update the content of their site. Most useful for
espousing your opinion, blogs typically don’t allow
for the downloading of additional files, unless you
use cloud storage or some other off­site storage
solution. Many of these also have a “cookie cutter”
appearance.
Another way you can create a web site is to hand
code your HTML. You can do this in a simple text
editor, or in a special HTML editor that helps write
the raw HTML code. There are many who subscribe
to and like using this method. Many view it as a “rite
of passage,” and proclaim it to be the “only way to
code HTML like a man.” Without a doubt, this is the
best way to create a custom web page, but it’s also
the easiest to get wrong.
Fortunately, for the rest of us wimps, there are
WYSIWYG (What You See Is What You Get) HTML
editors – like KompoZer. Working a lot like a
WYSIWYG word processor, such as LibreOffice
Writer, you create your web page much as you
would a term paper or typing a letter. You can
position your images and text exactly where you

want them, without having to learn a lot about HTML
coding. Of course, it’s a lot of help to know HTML
coding. The more you know, the more you can do
with the generated HTML code to customize it even
further.

Background
Back in February 2004, then Linspire CEO Kevin
Carmony wanted to create a simple, easy to use,
open source WYSIWYG HTML editor, based on the
Mozilla Gecko engine. He hired Daniel Glazman, a
former Netscape employee, as the lead developer to
help create Nvu (pronounced “N view”).

Development on Nvu stopped in 2006, and a
community fork of the Nvu source code continued on
– as KompoZer. The current version in the
PCLinuxOS repository is 0.8b3, released in
February 2010. It is based on Gecko 1.8.1. The
Gecko engine is currently at version 11, but the
older version that KompoZer is based on continues
to work well, even in the newer Gecko engine.
Despite the “K” in its name, KompoZer is not a KDE
application, no more than the Linux kernel is.
Instead, KompoZer is a Gtk+ application. Versions

exist for Linux, Windows and OS­X, giving it cross
platform support. It is developed by Fabien
Cazenave in his free time.
Meanwhile, Daniel Glazman went on to create
another WYSIWYG HTML editor from scratch,
based on Gecko and XULRunner, and called
BlueGriffon. While the core program is released as
GNU free software, many of the functions, add­ons
and the manual are available only after paying for
the modules you select. If you were to buy all the
modules, add­ons and the manual, you could end up
paying around $100. Without the purchase of the
modules, many of the features of BlueGriffon are
crippled and non­functioning.

Getting Acquainted
When you first launch KompoZer, you will see the
KompoZer Tip Of The Day dialog box (which can be
disabled, if you choose).

After that, you will find the main window displayed,
as below.

KompoZer: Let's Get Acquainted
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So, let’s break down the different areas of the
KompoZer window. Let’s start with the toolbar.
The KompoZer toolbar gives you one­click access to
many tools you will need when creating your HTML
page. The first three icons on the toolbar should be
self explanatory to any user. Hovering your mouse
over any of the toolbar icons will get you an
explanation displayed in a tooltip. We’ll discuss the

functions of most of these buttons in greater detail in
future articles. Right now, we’re just getting familiar
with them.
Publish enables you to publish the files that make
up your website. Typically, these are all stored in a
directory on your hard drive that mirrors the directory
and file structure on your website.

Browse allows you to open the saved version of the
file currently being edited or worked on in your
default web browser. Be sure to save your edits
before using the “Browse” button, or your new edits
won’t appear in your web browser.
Undo allows you to undo your most recent edits.
Redo allows you to put your most recent edits back
in, after you’ve removed them with the “Undo”
action.
Anchor places an anchor tag in your HTML at the
current cursor position. Let’s say you have a rather
long document, and you create an index or table of
contents for that document. By inserting anchor tags
at the appropriate places within that document, you
can link from the index or table of contents directly to
that specific anchor tag, without your user having to
scroll through the entire document to get there.
Anchor tags are typically given a unique name, with
# used as a prefix.
Link allows you to insert a HTML link into your
document. That link can be to a local file, or to a
resource hosted on another site. The “Link” button
will bring up the “Link Properties” dialog box, where
you can enter all the pertinent information for your
link.
Image allows you to insert an image into your
document at the current cursor position. KompoZer
will display the “Image Properties” dialog box that
will allow you to enter the necessary information for
your image.
Table allows you to insert a table into your HTML
document. Tables are a very powerful formatting tool
when creating HTML pages. KompoZer will display
the “Insert Table” dialog box, allowing you to define
the initial structure of your table. The table will be
immediately placed into your document at the
current cursor position, using your definitions as a
guide. If you double click your mouse cursor on the
table in your document, you can further tune your
table’s appearance to exactly what you want.KompoZer Toolbar

KompoZer: Let's Get Acquainted
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Form allows you to insert and set up a form in your
HTML document. We’ve all dealt with forms and
form elements within web pages. You use form
elements to sign into the PCLinuxOS forum, when
you insert your username and password to gain
access there.
HTML allows you to open up your HTML code for
editing in an external editor, if you have one set up.
CSS Editor allows you to edit the CSS (Cascading
Style Sheet) for your HTML document, which applies
a style sheet to your HTML document. The default
with KompoZer is to embed the style definitions into
the HTML header. It is possible to import an external
*.css file to control the styles of a group of pages.
Finally, at the far right of the toolbar is the KompoZer
logo. Mouse over the logo and a tooltip will appear,
declaring “This is KompoZer.” Otherwise, that’s all it
does.

Text Formatting Tools
The next two “toolbars” relate to your text formatting.
They appear like in the image below.
Starting with the top row, let’s review the text
formatting features. At the top left is the formatting
style of the text. The default is for body text. The
other choices are paragraph, headings one through
six, address, preformatted, or create an generic
division.
Working left to right, the next control allows you to
apply a class to either the text being entered, or the
selected text. The ! applies emphasis to the text,
while the !! applies strong emphasis. Basically,
applying emphasis to text is akin to making the text

italic, while strong emphasis is similar to making the
text bold. Selecting them both makes the text bold
italic.
The next control formats the text as a numbered list,
while the next one formats the text as a bulleted list.
Next are the controls to indent and outdent text. The
outdent control is disabled, unless you are dealing
with text that has previously been indented.
The next two controls don’t make a lot of sense to
me, as they are implemented in KompoZer. They are
called “Definition Term” and “Definition Description.”
I’m unable to find any documentation about them,
and in playing around with them, I can find no
rational use for them.
The last three controls on the top row of the text
formatting toolbar deals with layers. With KompoZer,
you can design layers into your web page. Briefly,
the use of layers allows precise positioning of an
element within your layout.
On the second row of text formatting controls,
starting from the left, the first control allows you to
select the font to use. The default is “Variable
Width,” but I usually prefer to select a specific font to
use for my web pages. It boils down to personal
preference of how you want your page to appear.
My personal preference is for a sans serif font, such
as Helvetica, Arial or Liberation Sans.
The next control sets the font color and the text
background color. Clicking on them allows you to
bring up a color selection dialog box where you can
define or select the colors of each. Right next to
those controls are the two controls to allow you to
make the text larger or smaller.

Next are the controls to determine whether your text
is bold, italic or underlined, just as you would find in
a word processing program.
The last controls determine the alignment of the text
in your HTML document. You can choose left
aligned, centered, right aligned, or justified. Again,
these controls work pretty much as they would in a
word processing program.

Site Manager

One of the neat functions of KompoZer is that it
allows you to manage your web site. Typically, when
you are creating or working on your site, there are a
number of files that comprise the whole. You would
normally store a copy of things to your hard drive,
arranged as they would be on your website. With
KompoZer, you can upload your all of the elements
of your site or just the changed pages to your web
host.KompoZer's Text Formatting Tools

KompoZer: Let's Get Acquainted
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Page Layout Area

The largest element of your KompoZer window is the
area where you enter and arrange the elements of
your HTML page. Think of it as your canvas. Or think
of it as your blank page as you might have in a word
processing program. Just as you might do typing out
a letter or a term paper, you enter the information for
your web page exactly the same way.
At the bottom of the page layout area, you see three
“tabs” on the left. The “Design” tab is the default

view, and displays the information you are entering
in a WYSIWYG manner. That is, how it appears on
your screen is pretty close to how it will appear when
a visitor to your website might see it in their browser.
The “Source” tab allows you to view and edit the
generated HTML code, something you might want to
do when you use or add elements to your web page
that aren’t supported by KompoZer. The “Split” tab
allows you to have a WYSIWYG display of your
page content in the top part of the window, while

displaying the generated HTML code in the bottom
part of the window – in a split view.
At the bottom right of the page layout section of the
Kompozer window is a control that determines how
your page layout window appears. The default is the
“Normal” setting. You can also set it to the “Preview”
setting, (although I can’t see any difference between
the normal and preview settings). You can also set it
to the “HTML Tags” setting, which displays the
HTML tags for each element of your page in your
WYSIWYG page layout window, right next to each
individual element of your page. To be perfectly
honest, I never alter the view. I choose, instead, to
switch between the design tab and the source tab
when working on my pages.

Status Bar
At the bottom of the KompoZer window is the status
bar. The status bar will display the general HTML
tags of the current section of your HTML page.

Summary
Now that you’ve gotten a quick overview of some of
the features of the KompoZer window, you should
be better able to find your way around KompoZer.
Don’t worry – there’s lots more that we haven’t even
touched on yet. Next time, we’ll talk about setting up
your site, and get started creating your first HTML
page.

KompoZer Text Input, below

KompoZer Status Bar

KompoZer: Let's Get Acquainted
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by Darrel Johnston (djohnston)

I cringe when I read an article about someone who
is running Linux on an “old” computer from 2005.
Old? That’s not old. I’m still using a Dell Pentium III
from 1999. I’ll bet most of the personal computers
made in 2005 did not come with floppy drives. My
Dell did. And, unlike USB devices, the floppy drive is
not polled by the hardware or the software to see if a
volume has been inserted or removed. The user
must manually mount and unmount each floppy disk
inserted into the drive.
Fortunately, it is fairly easy to use GUI tools to
enable the floppy drive for easy use. We can also
create GUI tools to mount and unmount floppy disks,
and to read and copy the contents of floppy disks.
We must begin the setup in PCC, the PCLinuxOS
Control Center. Click Local disks in the left pane of
the window.

If the Floppy drive icon option is not showing in the
right pane, the system is not reading the hardware
device. Check the computer’s BIOS settings and all
drive cables. Click the Floppy drive icon in the right
pane.

The default options presented should be the correct
ones. The image above is difficult to read. The
options are:
Mount point: /media/floppy
Device: fd0
Name: H1440
Type: auto
Options:
umask=0,users,iocharset=utf8,noauto,flush,exec
Click the OK button.

Click the Yes button to save the /etc/fstab
modifications. Close the PCC window. Your
/etc/fstab file should contain a new line:
/dev/fd0 /media/floppy autoumask=0,users,iocharset=utf8,noauto,flush,exec 0 0
It would be handy to have a standard place to
access the contents of a floppy disk. We can create
a shortcut to the floppy in our favorite file browser. I
am using PCManFM in the illustration. The
instructions presented will also work in Thunar,
Nautilus and Dolphin. Open the file browser and
navigate to the /media directory (next page, top).
Drag and drop the floppy folder icon from the right
pane to the bottom of the left pane (next page, left
center).
We now have a shortcut, or link, in the left pane of
the file manager window we can click on to access
the contents of a mounted floppy disk. At this point,

Mounting A Floppy Under PCLinuxOS
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we can manually mount and unmount a floppy disk
that is inserted into the drive. We can do both from a
terminal as a regular user. Insert a floppy disk into
the drive and open a terminal. To mount the floppy
for use, enter the command:
mount /dev/fd0
To unmount a floppy, enter the command:
umount /media/floppy

Once mounted, the contents of the floppy disk can
be accessed in the file manager by clicking the
floppy disk icon in the left pane.

But, we still have to manually mount and unmount
the floppies from a terminal using the command line.
That, too, is easily overcome. We will create two
desktop files, one for mounting a floppy and one for
unmounting. Open a text editor. Enter the following
text:
[Desktop Entry]Type=ApplicationIcon=/usr/share/icons/gnome/48x48/devices/media­floppy.pngName=MountFloppyComment=Mount a floppy diskCategories=FileManager;X­MandrivaLinux­System­FileTools;Exec=mount /dev/fd0StartupNotify=trueTerminal=falseMimeType=x­directory/normal;inode/directory;X­Desktop­File­Install­Version=0.18
Save the file as floppy_mount.desktop. In the same
text editor, enter the following text as a new file:

[Desktop Entry]Type=ApplicationIcon=/usr/share/icons/gnome/48x48/devices/media­flash.pngName=UnmountFloppyComment=Unmount a floppy diskCategories=FileManager;X­MandrivaLinux­System­FileTools;Exec=umount /media/floppyStartupNotify=trueTerminal=falseMimeType=x­directory/normal;inode/directory;X­Desktop­File­Install­Version=0.18
Save the file as floppy_unmount.desktop. We have
now created two desktop files that can be used to
mount and unmount floppy disks. The files can be
copied to your desktop or to any folder owned by
you. For convenience, we also want the entries to
show up in the PCLinuxOS menu. The system wide
menu entries can be found in
/usr/share/applications. However, the two desktop
files are not provided by any installed package, and
we don’t want to go to the extra effort of creating
them again, should we reinstall the operating system
at some point. For that reason, copy both
floppy_mount.desktop and floppy_unmount.desktop
files to ~/.local/share/applications. That is, copy the
desktop files the the .local/share/applications folder
in your home directory. The .local folder is hidden,
so set your file browser to show hidden files before
copying. Once copied, you will see two new entries:
MountFloppy and UnmountFloppy

in the File Tools section of the PCLinuxOS menu. I
chose two standard icons that should be installed by
default on any PCLinuxOS version. Change the
Icon= line in the desktop files to choose any other
icon you wish.

Mounting A Floppy Under PCLinuxOS
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Screenshot ShowcaseScreenshot Showcase
PCLinuxOS Magazine Mailing List:

http://groups.google.com/group/pclinuxos­magazine
PCLinuxOS Magazine Web Site:

http://pclosmag.com/
PCLinuxOS Magazine Forums:

http://www.pclinuxos.com/forum/index.php?board=34.0

Reach Us On The Web

Visit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclosmag"
(without the quotes)

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.

LinPC.us

Posted by cstrike77, June 4, 2012, running KDE4.

http://groups.google.com/group/pclinuxos-magazine
http://pclosmag.com
http://www.pclinuxos.com/forum/index.php?board=34.0
http://groups.google.com/group/pclinuxos-magazine
http://www.linpc.us


PCLinuxOS Magazine Page 18

by Paul Arnote (parnote)

Lordy, lordy. I love that I subscribe to Windows tips
and news email lists. Often times, it’s like that quote
from Forrest Gump: “Momma always said life is like
a box of chocolates. You never know what you’re
gonna get.”
What’s that? You’re surprised that the editor of a
Linux magazine would subscribe to and read such
things? Don’t be, because it’s resulted in quite a few
articles of how to do things in Linux. If nothing else,
those Windows articles get the gears turning. I
always read those articles with the thought of “how
is this of interest to Linux users?” Plus, it’s helpful to
stay informed on what the Evil Empire and Darth
Ballmer are up to.
Such was the case once again on May 23, 2012,
when I received the Windows Desktop newsletter
from TechRepublic. Featured in there was a tip on
how to use Microsoft Word to fill out forms. I got to
thinking, “I can do that in LibreOffice.”
To prove that I could, I downloaded the 2011 Form
1040­EZ tax form from the IRS web site. Sure
enough, you can do it in LibreOffice and AbiWord.
Not only can you do it in either of those two
applications, but you can do it much easier. Take
that Microsoft Word!
What follows is an explanation on how to do it. We’ll
start with the Microsoft Word method, which can
easily be replicated in LibreOffice. It’s a bit involved,
but it’s easier than it sounds. You just got to know
which hoops to jump through. Then, I’ll show you the
much simpler ways, in both LibreOffice Writer and
AbiWord.

Step One: Obtain & Convert The Form
This step is common between all three methods I’ll
show you, so I’ve separated this step to stand alone.
Obtaining the IRS Form 1040­EZ to use as an
example was easy enough. I simply went to their
website and downloaded the latest version available,
snagging the PDF of the form for 2011.
Next, open the PDF file in Gimp. Yes, Gimp will
open PDF files, in case you didn’t know. Just right
click on a PDF file and select “Open With...” then
Gimp. You will get this window:

Click on the page you want to import. In the example
above, it’s only the first page of the single page tax
form. The second page contains only the
instructions for filling out the form. Click the “Import”
button in the bottom right corner of the window.
Once the form opens in Gimp, save it as a PNG file.
You could save it as a JPG file, but I chose the PNG
format because of its lossless compression and
better results.

The Microsoft Word Way, In LibreOffice Writer
Using the same method as described for Microsoft
Word, we can achieve the same result from
LibreOffice Writer. Only the terminology is different,
since Word and Writer call the same functions by
different names.

Step Two: Set Your Document Background
Actually, this is where the bulk of the “trick” lies.
Open a new LibreOffice Writer document, move your
caret cursor into the header area and click on the
blue tab to enable editing of the header.

With the header now selected for editing, go to the
“Insert > Picture > From File...” menu item and insert

Use LibreOffice Writer, Abiword To Fill Out Forms

http://www.techrepublic.com/blog/msoffice/a-quick-word-trick-for-typing-text-into-a-scanned-document/8092?tag=nl.e064
http://www.irs.gov/pub/irs-pdf/f1040ez.pdf
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the PNG file we made in Step One. Double click on
the image after you have it placed in the header.

On the left side of the dialog box that appears, select
“Original Size.” We don’t want the image of our form
to fit neatly within the margins of our document.
Being a PDF form, it was intended for users to print
out, then fill out manually. Thus, our form already
has “margins” included (just not OUR margins). Your
LibreOffice Writer window should look something like
this:

Step Three: Set Up Text Wrap
With the background image of your form still
selected (as denoted by the small green resizing
marks around its edge), select the “Format > Wrap >

In Background” menu item. This moves your image
to the background of the document, and allows you
to enter text over the top of it. Using this method to
send your image to the background of your
document is a key step in getting this to work.

Step Four: Fill Out Your Form
To deselect the background image, click your mouse
in the gray area surrounding the document display.
Now, you should have your normal text entry caret
cursor flashing, awaiting your input. Using tabs and

spaces, move the caret to the locations where you
need to enter data on the form.
Note that you may need to modify your margins to
be able to “reach” all the areas of your form. You
may also have to play around a bit with fonts and
font sizes to get the proper line spacing for your
entered text. For me, I found that 10 point Liberation
Sans worked well, and gave me fairly good line
spacing that matched up with the line spacing on my
form. Here’s an example of the tax form filled out in
LibreOffice Writer (with fake information, of course):

Use LibreOffice Writer, Abiword To Fill Out Forms
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The Simpler LibreOffice Writer Way
Leave it to the folks who produce FOSS to find a
easier way to do things. LibreOffice Writer is no
exception. The instructions that follow presume that
you have already completed Step One and made a
PNG file of your PDF form.

Step Two: Set Your Document Background
Select the “Format > Page...” menu item. Navigate
to the “Background” tab. In the upper left corner of
that tab is the “As” drop down. It defaults to Colors.
Click it and choose “Graphic” from the drop down
list. Then, click on the “Browse” button and select
the PNG file you made from the PDF in Step One.
Don’t close this dialog box out – yet. Click on the
“Apply” button.

Step Three: Set Your Margins
Then, select the “Page” tab, and set all of your
margins to 0.00 inches (or whatever other
measuring units you are using). Remember, our
form graphic already has margins included, so we
really don’t need to worry about margins.

Click on the “OK” button to accept your changes and
close out the dialog box. You will get the following
message box displayed:

Select “Yes” to dismiss the warning box.

Step Four: Fill Out Your Form
Voila! Your blank form should now appear as the
background graphic in your LibreOffice Writer
document, similar to that pictured above. Just as
with the previous method, you will have to mess
around with the choice of font and font size to get a
line spacing that matches up with that of the form.
Again, 10 point Liberation Sans seems to work fine
for me with this particular form. As you enter your
data, it will appear over the top of your background
image. Once more, use a combination of tabs and
spaces to move the caret to the positions on the
form where you need to enter text.

The Ultra­Easy AbiWord Method
Sometimes, it seems downright criminal that
AbiWord is as often overlooked as it is. In case
you’re not familiar with it, it’s a small, but powerful,
cross­platform word processor. In keeping true to its
FOSS origins, it does one thing, and does it well –
word processing.
Using AbiWord to fill out forms is the easiest of all
the methods described here.

Step Two: Set Your Document Background
Select the “Format > Page Background > Page
Image” menu item, then select the PNG file you
created from the PDF in Step One.
That’s it. It’s very, very easy.

Use LibreOffice Writer, Abiword To Fill Out Forms
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Step Three: Set Your Margins
Since Form 1040­EZ already uses 0.5 inch margins,
I set the margins in AbiWord to match.

Step Four: Fill Out Your Form
Voila! Just type in the information for your form. Just
as with the previous methods, you will most likely
have to play with the font and font size combination
to achieve proper alignment with your form. Once
again, I found that 10 point Liberation Sans seemed
to fill the bill quite nicely. As with the previous two
methods, use a combination of tabs and spaces to
move the text entry caret to where you need to enter
data on the form.

Summary

Without a doubt, we can do many of the same things
that Microsoft Word does. In many cases, as
illustrated here, we can do it much easier, thanks to
the FOSS developers keeping things simple. There
may be easier ways to do this in Microsoft Word, but
to be honest, I wouldn’t know. I haven’t (thankfully)
used Microsoft Word in years. I did go back and
review the comments to the original TechRepublic

article, and no one else had mentioned anything
about an easier way to do it in Word, either.
It just goes to show you that expensive commercial
software is not always better. It’s just … well … more
expensive!

Use LibreOffice Writer, Abiword To Fill Out Forms
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A is for Archie from China he hails
Giving fun and help he never fails
B is for Bald Brick an old blackbird
His posts in the forum are never absurd
C is for chilly do you smell all those fumes
Racing his car through the forum he zooms
D is for djohnston he does succeed
Writing magazine articles for us to read
E is for exploder he's like dynamite
Posts what he thinks and is always forthright
F is for frazelle09 friendly and fair
He is an asset anytime anywhere
G is for Georgetoon a comical chap
Can draw a cartoon in less than a snap

H is for horusfalcon he plays a mean bass
In the PCLinuxOS Band he has earned a place
I is for I that must mean ms_meme
Without a rhyme I never shall be
J is for jaydot a sensible guy
He is a mod so with him comply
K is for ka9yhd what does that signify
Perhaps a code name for a private eye
L is for Leiche he really works hard
He is held in the Forum with high regard
M is for MeeMaw always has time for a friend
In any forum she will easily blend
N is for nok his posts are amusing
Right to the point and never confusing

Forum Foibles:ms_meme's Forum ABC BOOK
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O is for OMSkates thru the forum he does cruise
Read his topics for the latest news
P is for parnote his talents are many
In the Magazine you'll find them a plenty
Q is for question I ask you with sense
Why use Windows there is no defense
R is for Rudge a dog's life he leads
And to the forum he's the best of the breeds
S is for smileeb always posting with ease
Whatever he writes it is certain to please
T is for timeth our resident artist
With Gimp and Inkscape he is the smartest

U is for U the PCLinuxOS Users
All forum members are very wise choosers
V is for Vortex friendly and fun
Amusing and humorous he's next to none
W is for weirdwolf none can exceed
He thinks he is strange and we are agreed
X is for Xenaflux so willing to teach us
His explanations never fail to reach us
Y is for YouCanToo writes Knowledge Base
He puts all the info in the right place
Z is for zillions of posts I read daily
As I sing and play songs on my ukulele

Forum Foibles:ms_meme's Forum ABC BOOK
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by AndrzejL

I had to move from a Packard Bell EasyNote W3301
laptop to my Acer Travelmate 2420 due to a
hardware failure. I moved the hard drive from one
lappy to another. This was a little “hacky,, but it
worked.
The first thing I noticed was a “Battery broken”
annoyance each time my machine would boot to
KDE4. Yes, thank you, I know the battery sucks and
that I cannot afford a new one. Now please bugger
off and stop rubbing the fact in.
I finally got rid of it. Here is how.
Open konsole and type in:
systemsettings followed by the <Enter> key.

The KDE4 Control Center will pop up. Now go to
Hardware > Power Management > Global
Settings.

Now click on the Configure Notifications button. A
new window will pop up. Look for a Broken battery
notification entry and click on it.

Now uncheck the Play a sound and Show a
message in a popup boxes. Click on the OK button
to close the window, then close KCC and Konsole.

On next reboot/log in, the annoying message won’t
bother you any more.

Eliminate Annoying Messages in KDE4

http://www.linuxfoundation.org/
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by Meemaw
The fourth installment of our series is GnuCash
http://www.gnucash.org/, which is available for
Linux, Mac and Windows. The User Guide is at
http://www.gnucash.org/docs.phtml. GnuCash is in
the PCLinuxOS Repository.
Starting the program for the first time, the following
window appears:

If for some reason you already have a set of
accounts saved, you can click Cancel and open
them from the main window. Instead, we will create
a new set of accounts, so click OK. You will be
presented with a series of windows that will help you
create your set of accounts.

GnuCash has several ‘pre­made’ sets of categories,
or account types, as shown in the left side of the
window below. You may add as many as you wish.

I have added the “Common Accounts” set. If
you find that you need a category you don’t
have, it can be added by hand, and any of the
existing categories can be edited to your
preference.

While you have your category list open, you can edit
any of them. Click on each Asset account (at least
the Checking and Savings) and enter an Opening
Balance (bottom left).
When you finish, you will have a window like the one
below. Equity is Assets minus Expenses. Since
there have been no expenses entered yet, Equity is
the total of the asset accounts.

If you remember, iFreeBudget’s left side tree looks
pretty much the same. GnuCash also uses double­
entry bookkeeping, which means that everything is
an account, even the categories. It also means that
each transaction is entered twice, once as a debit
from an account, and once as a credit to another
account. When you enter a transaction into your
checkbook, the transaction’s corresponding entry to
a category is made automatically. After you add your
transactions, you will find that the categories also
have balance amounts in them as well.

Linux Financial Programs: GnuCash

http://www.gnucash.org/
http://www.gnucash.org/docs.phtml
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Double­click on the Checking Account to open it. We
will enter our transactions here. From the View
menu, you can set your register to be single­ or
double­line display, and choose a basic ledger, auto­
split ledger, or a transaction journal. The ledgers
aren’t that much different, but the transaction journal
shows both entries for each transaction (double­
entry bookkeeping), and unless you are used to it, it
may confuse you a bit. I chose the basic ledger.

The two lines colored yellow at the bottom of the
display are for entering your transaction. All you
really have to enter is the date, check number,
payee, category and amount. In the double­line
display, you have a line in which to add notes about
a payment. (Prom dress for daughter?) GnuCash
memorizes your transactions and payees, so if you
start to enter a payee you already have, it will be
filled in for you. All you will then have to do is tab
over to the amount and change it if it’s different.
Notice also that each account you open is a tab at
the top, so if you want, you may have your checking
and savings accounts open at the same time and
just alternate between tabs.
When you save and close the accounts, you will see
your main screen again. Notice that the Expenses
categories now have amounts in them (top right).

The Reports menu has many reports that can
be viewed, and you can customize your own
report if you wish.

GnuCash does Scheduled transactions two different
ways. The first way is from the check register. If the
transaction you have been adding is supposed to
happen on a regular basis, you can go to the toolbar
and click on the
button that looks
like a calendar with
a plus sign.

Scheduled transactions can also be
created from clicking on the Actions
menu.

You will see several items in the Tools
menu. You can set up Online Banking
from here. I don’t do online banking from

any financial program, but it looks pretty
straightforward, as long as you have all the required
information.
The Price & Security Editors are for your
investment accounts.

The Loan Repayment Calculator (above) is quick
& handy to figure out your payment if you are
borrowing money. Just clear all the options, then

Linux Financial Programs: GnuCash
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enter your loan amount, interest rate, future value
and number of payments. Click “Calculate” and the
payment amount will be calculated. In the example
below, I set the amount I want to borrow as the
Present Value, and zero as the Future Value
(because I want the loan to be paid off). I put in the
interest rate and number of payments, leaving the
Periodic payment blank. Clicking “Calculate”, we see
that the monthly payment is now filled in.
The Close Book item is for an account you are
closing.
You can pull up a General Ledger for your accounts
as well.
Notice that you have a menu item called Business.
If you want to manage your business accounts, you
can use GnuCash. You can use the business
categories rather than the standard set, and the
program includes menu items to create Vendors,
Customers, Employees, Payment Vouchers,
Jobs and Invoices. In addition, the accounts you
use include Accounts Receivable and Accounts
Payable. If you have a business, this may be a good
program to manage it.

I have found GnuCash to be a good program that
works well. The only problem I see is that it saves
two files in addition to the data file every time it
saves. Again, this is my personal opinion. However,
if you set the program to auto­save every ten
minutes and you work with it for an hour, you will
have a file list in your save location that looks
something like this:

My main file is the first in the list, but you will see
several sets of files that include a log and an
application file. If you open the program every day,
this can fill up your /home folder pretty fast. The
Preferences can be set to solve some of that, as
you see here:
You can set to save every 30 minutes or hour, and
only save the log files for 5 days or less. Set it
however it works best for you.
Next month we will look at KMyMoney.

Support PCLinuxOS! Get Your Official
PCLinuxOS
Merchandise Today!

Linux Financial Programs: GnuCash
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Posted by ff103, June 1, 2012, running KDE4.
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by Patrick G Horneker (phorneker)
In the last article, we installed FreeDOS on a virtual
machine with QEMU, and placed the disk image in
the ~/vm directory.
We already learned some parameters that we used
when invoking qemu, namely ­hda to specify the
hard disk image to use, ­cdrom for the CD image we
used to install FreeDOS, ­boot d to tell QEMU to
start using the CD/DVD image, and ­m 32 to tell
QEMU to allocate 32MB of memory to FreeDOS.
QEMU comes with many more parameters than this,
as we are using QEMU to emulate a old school PC.
So far, we typed the following to start QEMU:
qemu ­hda freedos.img ­cdromiso/fd11src.iso ­boot d ­m 32
Once installed, we will need to launch QEMU and
have it boot from the emulated hard disk. For this,
we only need the name of the hard disk image.
Hence, we can start QEMU with the following:
qemu ­hda freedos.img ­boot c ­m 32
This will launch QEMU and give us the following (top
right):

The virtual CD­ROM drive is present, but there is no
virtual CD in the drive. If we supplied a CD image
with the command, then you will be able to access
the CD­ROM from drive D on FreeDOS. However,
notice there is no floppy drive available. When
we try to access the floppy on FreeDOS, we get the
following (right, center):

We could add a floppy drive to our QEMU command
line. There are two ways to do this, and it depends
upon the physical hardware available on your
machine. Older machines come with internal floppy
drives, and they can be used directly within QEMU.
Over the past few years, desktops do not come with
internal floppy drives, and to use floppies on these,
you will need an external floppy drive (these should
be very inexpensive by now, if you can find them in
the first place).

To use a floppy disk image, you supply ­fda to
represent the first floppy drive, and ­fdb to represent
the second floppy drive. Back in the day, internal
floppy diskette controllers could only support up to
two floppy drives. This was always the case for
every PC built.
QEMU supports either a disk image or a physical
device (internal floppy drives only).
­fda /dev/fd0 tells QEMU to use the first physical
floppy drive on your machine for floppy access.
­fda /dev/fd1 tells QEMU to use the second physical
floppy drive on your machine. Note: This parameter
is not valid if your machine has only one floppy
drive.
External Floppy Drives
External floppy drives can be used to create floppy
images for use on QEMU. On QEMU, floppy images
are mounted the same as physical floppies that are
inserted in a internal floppy drive. Since external
floppy drives are USB mass storage drives, they
have device names such as /dev/sdb, /dev/sdc,
/dev/sdd. The USB mass storage driver uses SCSI
emulation for disk operations, and hence must be
explicitly mounted before reading and writing to the
disk. This is not the case with internal floppy drives.

To create a disk image from a floppy inserted into an
external floppy drive, we need to find the device
name for the external floppy drive. First, insert the
floppy you want to use in the external drive. On
most PCLinuxOS desktops, an icon should appear
representing the floppy. Open a terminal window
and type in ls /dev/sd* to get a list of disk devices.

QEMU, The Other Virtual Machine, Part Two
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/dev/sda /dev/sda1 /dev/sda2 /dev/sda3
/dev/sda5 /dev/sdb /dev/sdc /dev/sdd
/dev/sdd1
On my laptop, when docked, the external floppy has
a device name of /dev/sdd. /dev/sdd1 refers to the
FAT16 partition on the floppy. /dev/sdd refers to the
disk drive and the unformatted (raw) disk inserted
into the drive. The latter is what we want to use to
create the disk image.
(/dev/sdb refers to the built­in memory card reader
and /dev/sdc refers to the card reader built into my
Epson Stylus NX415 all­in­one device.)
With the terminal window open, go to an empty
directory (I use ~/vm/floppies to store floppy disk
images) and use the dd command as follows:
dd if=/dev/sdd of=<name of diskimage>.img bs=512
where name of disk image is the name you assign to
the disk image. The bs=512 tells dd that each block
size on the disk image is 512 bytes in length.

Creating Blank Floppy Images
Just as we can create
hard disk images with
qemu­img, we can
create floppy disk
images the same way.
In a terminal window,
we just type the
following: ­­­­­>

We now have a blank
floppy disk image to use
with QEMU. On
PCLinuxOS, there is no

need to run sudo or su to accomplish this as
mkdosfs formats a disk image (or physical disk)
with the FAT16 filesystem.
To use this disk image, we need to supply ­fda
floppies/blankfloppy.img to the command line,
preferably before the ­hda parameter. So now, our
command line to invoke QEMU looks like this:
qemu ­fda floppies/blankfloppy.img­hda freedos.img ­boot c ­m 32
Now, when we access the floppy drive (by typing a:),
we get what we expected: A:>_ .

By supplying the
­fda parameter,
we tell QEMU
that there is a
floppy drive
available on the
emulated
machine, and
there is a floppy
in the drive.

The CD/DVD­ROM Drive
We already know that we can use CD/DVD images
on QEMU. The ­cdrom parameter supplies QEMU
with a CD/DVD disk image to use for the emulated
CD/DVD ROM drive. The ­hdb parameter is the
same as ­cdrom as it represents the same device.
However, images and physical devices supplied with
­cdrom are used as read only devices, where
devices supplied with the ­hdb parameter are
available for reading and writing.
We already used ­cdrom for installation of
FreeDOS. We can use ­cdrom for CD/DVD images
we want to use with FreeDOS.
FreeDOS comes with a DOS ATAPI driver which
was installed with the distribution. The ATAPI driver
does not support writing to blank CD or DVD discs.
But then, CD or DVD writing was never supported
under DOS.
We can use ­cdrom for production use of QEMU.
To use it, we need a CD/DVD image, or we can
supply a physical CD/DVD device.
On my laptop, the DVD burner has a device name of
/dev/sr0, which could be used. If you are using an
external drive, your device name will vary (such as
/dev/sdb).
While you may use a physical CD/DVD drive, it is
more efficient, performance wise, to use CD/DVD
ISO images on QEMU because of the overhead
needed to access the physical drive on QEMU.
For purposes of this article, let us use the original
­cdrom parameter. Our command line now looks
like this:
qemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32
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Serial and Parallel Ports
Just as old school PCs have serial and parallel ports
to communicate with devices such as printers and
(landline) modems, QEMU can emulate these ports
using the ­serial and ­parallel parameters.
QEMU can emulate four serial and three parallel
ports. (For FreeDOS, these are devices named
COM1: through COM4: for the serial ports, and
LPT1:, LPT2: and LPT3: for the parallel ports.)
For each emulated port, we need to supply either a
­serial or ­parallel parameter with the name of the
physical device or file to be used. The order of the
parameters matters here.
When you supply the parameters, the first ­serial
parameter supplied emulates the first serial port, the
second ­serial port emulates the second serial port,
and so forth. The same is true for the parallel ports.
I recommend physical devices for emulaton of serial
ports as they are devices that can read AND write
data. The parallel port emulation can be either a
physical device or a file. I recommend a file for this
parameter. QEMU does not recognize the CUPS
system for printing, and the use of physical devices
for parallel emulation could interfere with the
opeation of CUPS as QEMU bypasses the CUPS
system to write directly to the physical port.

What to use for serial ports
­serial /dev/ttySx: This uses a physical serial port
on your machine. Usually, this port can be found on
legacy machines.
­serial /dev/ttyACMx: This appears when you wish
to use a cellular phone (not a smartphone) as a
modem, or have a USB landline modem plugged in.
­serial /dev/ttyUSBx: This appears when you have
a serial to USB adapter plugged in. This device also

appears when you begin to synchronize older
PalmOS devices using a cradle or direct connection
to the device. However, I do not recommend USB
cradles for such devices being used because the
device does not appear until the device is ready to
be synced. For older PalmOS devices, I
recommend using a serial cradle attached to a serial
to USB cable instead. This way, the device name is
always available which is what QEMU expects for
serial device access.

What to use for parallel ports
­parallel /dev/lpx: This uses a physical parallel port
on your machine. This parameter is invalid for
machines without parallel ports, such as netbooks,
Ultrabooks, intel­based Macs, and newer desktops
and laptops. If your machine has a parallel port, by
all means use it. QEMU bypasses CUPS and sends
output directly to the parallel port.
­parallel file:filename: I recommend this parameter
for emulation of the parallel port. QEMU will write
any output for the emulated parallel port to filename.
When you exit a QEMU session, filename will be
available on the directory where you launched
QEMU, and contains raw output that would have
gone to a physical printer.
I recommend you make filename a PostScript file,
i.e. give the filename a .ps extension. For example,
we could use ­parallel file:printer0.ps to emulate a
PostScript­enabled printer connected to a parallel
port. Then, configure DOS applications to output
PostScript. After you leave QEMU, you can then
view printer0.ps with Evince, Okular, or gv, or send
it directly to a printer with the lpr command.
If you have an Epson printer (all­in­one or stand
alone), you can configure DOS applications to print
to an Epson printer (any model). In this case, you
can give filename whatever you want. Why?
Epson’s ESC/P­R is an object oriented superset of

the ESC/P and ESC/P2 printer control languages,
and hence newer Epson printers are backwards
compatible with even the oldest Epson printers.
Many Hewlett­Packard printers still use the PCL 6
control language. In this case, you may configure
DOS applications to print to most Deskjet and
LaserJet models. You may give filename a .pcl
extension so you know this file contains PCL coding.
If you configure filename to output to Epson or HP
control languages, you will need to print the file
using lpr ­r command where ­r tells lpr to send the
data as­is (the r stands for raw output).
Even then, output to PostScript guarantees that
output from DOS applications will print correctly after
the QEMU session using the lpr command.

Building the Command Line
For purposes of this article, we shall configure
FreeDOS to use a 56K modem and a PostScript
printer. This was a typical configuration for an old
school PC.
For actual hardware, I shall be using a Zoom 56K
USB Modem for the serial port. This modem is
Linux compatible and provides the /dev/ttyACM0
name we need for ­serial.
If you wish to use a cellular phone (not a
smartphone) as a modem, be sure to check your
carrier’s Terms of Service to see if such usage is
allowed before connecting your cell phone.
For the parallel port, let us configure ­parallel
file:printer0.ps. All output to LPT1: from FreeDOS
will be written to printer0.ps. DOS applications
running on FreeDOS need to be configured to write
PostScript output. I recommend using any of the
Apple Laserwriter drivers or Generic PostScript
drivers.
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Using this hardware, our QEMU command line now
looks like this:
qemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32 ­serial/dev/ttyACM0 ­parallelfile:printer0.ps
Be sure to plug in the USB modem before
invoking QEMU with the above command line.

Mounting QEMU disk images
Under PCLinuxOS (and other Linux systems), you
can mount a QEMU image and access it like any
other directory. This is useful for installation of DOS
drivers without having to access a floppy drive.
Open a terminal window and login as root, then type
in the following (lines separated for clarity):
mkdir ­p /mnt/freedos
mount ­o loop,offset=32256/home/patrick/vm/freedos.img/mnt/freedos
cp /home/patrick/<name of directorywhere DOS driver files are>/mnt/freedosumount /mnt/freedos
For QEMU images, you need to mount the image
using the ­o loop,offset=32256 parameter. This is
where the filesystem created by FreeDOS starts on
the QEMU disk image.
This section is important as the next hardware
components to be configured require DOS drivers to
function. We need a way to get the drivers into
FreeDOS.
Besides the above, we could download the required

DOS drivers, and transfer them to a memory card, or
burn them to a CD­R/DVD­R, then mount that for a
hard drive and transfer the files that way.
Audio Hardware
QEMU emulates some audio hardware. Typingqemu ­soundhw ? (Yes, type the question mark to
get information on all sound cards supported by
QEMU.)

For FreeDOS, we can configure the Sound Blaster
16 device. We will need to download DOS drivers
for these devices. Drivers for these devices can be
downloaded from
http://support.creative.com
To download, click on Sound Blaster, then scroll to
the bottom of the next page. Where it says “If your
Product is not Listed above”, click on the text link
labelled “Please click here”.
Go to the list that appears and select Others. Then,
under Archived Products, click on Sound Blaster 16.
Then, click on Next. Scroll to the bottom of the next
page. Under All Downloads, click where it says
Windows NT 4.0, then select DOS from the popup
menu. Click on Submit, the link to the DOS driver
will appear in the results. The file is 1.15MB in size.
On this page is the link to the driver download. Click

on Download and agree to the end user license.
The file will download to the Downloads directory on
your user space, and is called sbbasic.exe, which is
a self extracting DOS executable.
Now, let us add the audio support to the
command line
Since we are going to use the Sound Blaster 16 for
audio support, we need to add ­soundhw sb16 to
the command line. We shall insert this parameter
before the ­serial and ­parallel parameters. So far,
the following is our QEMU command line to invoke
the emulator:
qemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32 ­soundhwsb16 ­serial /dev/ttyACM0 ­parallelfile:printer0.ps
All of this is actually one line of code. We have
what we need so far to emulate a old school PC as a
standalone machine. Since this is a large one line
command, it would be a good idea to create a shell
script to run this emulator without having to type all
of this code.

Shell Scripts to make QEMU launch easier
The first thing we should do is create a bin directory
in your userspace (if you do not already have one).
Having a bin directory here allows you to run shell
scripts from your home directory simply by typing the
name of the script. ~/bin has already been
configured with your PCLinuxOS installation as part
of the listing of directories to search for programs to
run, so you do not have to configure anything else.
Open your favorite editor (e.g. kate, gedit, emacs,
or vim) and type in the following (next page):
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#!/bin/bashqemu ­fda floppies/blankfloppy.img­hda freedos.img ­cdromiso/fdsrc11.iso ­boot c ­m 32 ­soundhwsb16 ­serial /dev/ttyACM0 ­parallelfile:printer0.ps
The last five lines are actually one line of code.
Save the file to whatever you want to your ~/bin
directory (for example freedos) and exit the editor.
Then, open a terminal and type the following:
chmod a+x ~/bin/freedos
Now, typing freedos will launch QEMU with the
command line options we created. Since this is a
text file, we can change any parameters we want
when we need to.
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by Paul Arnote (parnote)

Dropbox users on KDE can right click on a file in
their Dropbox/Public folder in Dolphin or Konqueror
and get the URL of the file to share with others.
Dropbox users on Gnome can right click on a file in
their Dropbox/Public folder in Nautilus and get the
file to share with others. However, users of Xfce’s
Thunar file manager had to resort to logging into
their Dropbox account, via their web browser, and
obtaining the URL of a file in their Dropbox/Public
folder by right clicking on the file, then selecting to
copy the URL to their clipboard. In fact, any user can
do that on any desktop, but it’s a much slower
process with many more steps.
Until now.
I recently made a Package Request in the
PCLinuxOS forum for a command line utility we
didn’t have in the PCLinuxOS repository. Now that
the new command line utility has been graciously
provided by our packagers, it’s possible to create a
Custom Action in Thunar that gives Xfce users the
same ability as their KDE and Gnome brethren. The
packager who packaged the utility seemed to be a
bit puzzled by my request, and about why I wanted
it. Now that the cat is out of the bag, let me show
you how to do it.

Step One
Open Synaptic, and make sure you are fully
updated. Then, search for and install the “xclip”
command line utility. Don’t worry. It’s a relatively
small utility and it won’t take up much space on your
system. The xclip utility copies information from the
command line to your desktop clipboard. That

information can be whatever textual data you obtain
from the command line, or it could be entire files. It’s
a handy little utility that I’m sure you can find other
uses for. Check out the xclip man page for a full
description of its capabilities.

Step Two
Now, you will need to install the Dropbox command
line utility, called simply dropbox.py. Being a Python
script with no external dependencies, it won’t mess
up your system. Follow this link and download it to
the Downloads folder on your computer. The file is
only 91 KiB in size.
On my computer, I went to the hidden .local folder in
my /home directory, and created a new folder there
called “dropbox­script.” I placed a copy of
dropbox.py inside that new directory. I then set the
file as executable in the “Permissions” tab of the
file’s property settings (see the graphic on the right).

Step Three
Next, we’ll make a small custom bash script to
handle the calls to the dropbox.py script. Here’s the
bash script that I wrote:
#! /bin/bash
s=`~/.local/dropbox­script/dropbox.pypuburl "$1"`
zenity ­­info ­­text="$s" && echo "$s" |xclip ­selection c
I got my inspiration for this script from a Nautilus
script that I found. As far as I know, Thunar can’t just
use Nautilus scripts without alteration. So, I set out

to alter the original Nautilus script so that I could use
it with Thunar.
Of course, the first line identifies the script as a bash
file. The second line feeds the results of the call to
dropbox.py into the variable named “s.” Notice that I
have pointed the bash script to the folder where I
stored a copy of dropbox.py. The third line displays
the result of the call to dropbox.py in a Zenity dialog
box, and then uses xclip to copy that result to your
desktop clipboard.

I stored the bash script as puburl.sh in my /usr/bin
directory. Don’t forget that you can only write files to
the /usr/bin directory as the root user. (Hint: save a
copy somewhere in your /home directory, then copy
the file to your /usr/bin directory as root). Don’t forget

Thunar Custom Action For Dropbox Public URL
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to set the file as executable in the “Permissions” tab
of the file’s property settings.

Step Four
Now we need to set up the Thunar custom action. If
you’ve never created a Custom Action in Thunar,
never fear – it’s relatively easy. Here’s a quick
review. First, select the “Edit > Configure custom
actions...” menu in Thunar. This will display the
dialog box below.

Of course, you can see that I already have the
Dropbox URL custom action set up. You will need to
select the “+” button at the top of the row of buttons
on the right to create a new custom action in Thunar.
This will bring up a dialog box similar to the one at
the top of the next column.
Fill in the fields as I have done in the image above.
On the top line, type in a brief name for your new
custom action. This is the text that will show up in
the Thunar context menu. On the second line, type
in a more descriptive phrase for your custom action.
On the third line, type in the command you want to
run. Notice that we are passing the Thunar
command parameter “%f” as part of the command
we want to run. The parameters are listed in the

bottom half of the dialog box. Finally, click on the
icon and select your own custom icon for the new
custom action. DO NOT click on OK – yet. You now
need to click on the “Appearance Conditions” tab at
the top of the dialog box.
In the “File Pattern” line, type a single asterisk (“*”).
Then, click on each of the check boxes to place a
checkmark in every one of the appearance
conditions. NOW you can click on the “OK” button.
You will be taken back to the first dialog box. Select
the “Close” button. Your new custom action will now
appear at the bottom of the context menu when you
right click on a file in Thunar.

Putting It To Use
Thanks to the dropbox.py script, it knows if you are
in Dropbox’s Public folder or not. If you click on a file

NOT in your Dropbox/Public folder, you will receive
the Zenity dialog box below.

However, if you click on a file that IS in your
Dropbox/Public folder, the public URL for that file will
be displayed in the Zenity dialog box (image, top of
next page).

Thunar Custom Action For Dropbox Public URL
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In either case, the text displayed in the Zenity dialog
box is copied to your desktop clipboard when you
select the “OK” button. I suppose the script could be
enhanced to not copy the error message to the
clipboard, but it works well enough for me, as is. I
tend to subscribe to the K.I.S.S. principle – Keep It
Super Simple.
Now, all that’s left is to paste the URL to your file in
the Dropbox/Public directory from your clipboard into
your email, chat client or instant messenger window
to share the file.

Too Good To Be True?
Unfortunately, it was recently announced that new
accounts created after July 31, 2012 will no longer
have a “Public” folder. While you could create a new
folder in your Dropbox folder called “Public,” it won’t
have the same functionality as the Public folder
created by the Dropbox installation. I first discovered
this news from this entry on the Scripting News
website. I confirmed it by checking at the Dropbox
help site. No reasons or explanation for the change
has been offered, and there’s only speculation as to
the reason for the change at the Scripting News
website. Current users will be allowed to retain their
“Public” folders and all the functionality it now
possesses – for now.

The resulting change will allow users to share links
to any file in any of your Dropbox folders – even
links to entire folders. However, the dropbox.py
script, as it’s currently written, will only work with the

Dropbox/Public folder as it is created by and setup
by the current Dropbox installation.
Hopefully, someone will update the dropbox.py
script to support the new change that allows users to
obtain a link to any file in any of your Dropbox
folders. Once that happens, the dropbox.py script
will have even greater appeal and functionality. Until
then, you can still use the laborious method of
logging into the Dropbox website and right clicking
on files in “other” directories to obtain the URL of a
particular file or directory to share with others. It may
take a while for the dropbox.py to be updated, since
someone will have to figure out how to calculate the
hash values that Dropbox applies to the files and
folders when creating the link URLs.
Fortunately, this custom action – as well as the right
click context menu items in KDE and Gnome – will
continue to work with the Dropbox/Public folder, just
so long as you are either a current Dropbox user, or
just so long as you sign up for your Dropbox account
before July 31, 2012. Again, for the time being, the
functionality of the Dropbox/Public folder will remain
intact for the aforementioned users.

Summary
Now, thanks to this relatively simple Thunar custom
action addition, Xfce users can enjoy the same
convenience feature as their KDE and Gnome
cousins. Of course, the whole thing is possible,
thanks to the xclip utility. It allows us an
exceptionally easy way to get the necessary
information to our desktop clipboard.
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by Meemaw
So, I’m at work, creating mailing labels for some
postcards, using LibreOffice. It’s giving me trouble,
too, kicking out a blank label sheet after every sheet
printed. I find myself wishing I had gLabels on my
Windows7 computer, because the process is easier
in gLabels. I actually have VirtualBox installed at
work and have two or three virtual desktops of
PCLinuxOS. However, if I enable the printer in
VBox, it is disabled and won’t work in Win7.
I end up using LibreOffice in Win7 and putting up
with the extra pages. If you don’t do many labels,
this is the procedure in LibreOffice. After you have
your label information in a spreadsheet, you save it
and create a new database in LO, designating your
spreadsheet as a database. Second, create a new
document (choose New > Labels) in LO, and
arrange the fields you need from your designated
database. Next, choosing Tools > Mail Merge
Wizard, proceed through the steps to merge your
database into your label pages. After you merge and
save, then you print your labels. This is when LO
doubles the number of pages needed and kicks out
a blank page after every printed one. There’s got to
be a better way!!!
In gLabels, you save your spreadsheet as a .csv file
to use. After designating your .csv file in gLabels,
you add merge fields, arrange the fields where you
want them, and print the labels.
It would have been nice to do that, but I still have the
printer problem I mentioned above.
While I’m ranting about it in IRC, it is suggested to
me that a pdf would be a much easier document to
print...

Wow!!! I can do that!
In LibreOffice, I save my merged labels, but instead
of printing them from there, I choose “Export Directly
as PDF” from the toolbar. When I pull up the
document, it is the correct number of pages and can
be printed from my pdf reader. (The example is only
2 pages.)

In gLabels, I save my labels,
and choose “Print”.
However, it is possible to
“Print to File”, so I choose
that instead, designate I
want the file to be a pdf and
name the file. When I click
“Print” the pdf is created.

This can be done with personal address labels as
well.

I have several mailing locations that I use all the
time and I have sheets of identical labels for them.
I have now saved each sheet of labels as a pdf so
I can print it any time I need a new sheet.

Labels, Anyone?
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Screenshot ShowcaseScreenshot Showcase

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Looking for an old article?Can't find what you want? Try the

PCLinuxOS Magazine'ssearchable index!

Posted by ferry_th, June 4, 2012, running Openbox.

mailto:pclinuxos.mag@gmail.com
http://pclosmag.com/html/sorted.html
http://www.tuxmachines.org
http://www.distrowatch.com
http://www.linuxforum.com
http://www.opensource.org/
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by AndrzejL
Yes, yes, yes. I know … Linux does not need
antivirus software. True. BUT then – if you are dual
booting with Windows, you may want to be able to
check the other OS once in a while for
rootkits/malware/spyware/rougeware/viruses and so
on and so forth. Even if you are not dual booting,
another way of using this would be to use your
remaster to check your computers at home that are
using Windows from the LiveCD/LiveDVD level.
Seems useful, right? You can access the Windows
partitions with read/write permissions under your
PCLinuxOS. Nastiness cannot hide itself from the
antivirus with a few entries in the registry. Sounds
really good. So how does one install Avast on the
PCLinuxOS?
First, we need to download a copy of it. It’s legal and
free, if you are using it at home on non­commercial
machines. For more info read the Terms and
Conditions.
Open your favorite terminal and issue this command
(all on one line):
wget ­chttp://files.avast.com/files/linux/avast4workstation­1.3.0­1.i586.rpm

Now wait for it to finish downloading.

Done, right?

Now, you need to gain root privileges. Issue this
command:
su

Enter the root password when asked.
Now, for the installation part ­ issue this command:

apt­get install avast4workstation­1.3.0­1.i586.rpm
and wait for it to finish.

Done?

Great. Now issue those two commands:
echo '' >> /etc/rc.local

Installing Avast AntivirusHome Edition on PCLinuxOS
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echo 'echo 128000000>/proc/sys/kernel/shmmax' >>/etc/rc.local

Done?
Close the Konsole
window and go to
Kmenu. (Ed. Note: If
you are using
something other than
KDE, you can search
for applications.) Type
ava in the search box.

There you go. That’s your Avast Antivirus. Click in it.
The registration box will pop­up.

Click on the “Click here to obtain registration key”
link. You can choose what browser you want to use.

Fill out registration form correctly and wait for the e­
mail from Avast with your product key.

Copy and paste the registration key into the
Registration window and click OK.

You have just installed Avast Home Edition for Linux
workstations.

Close the avast window and reboot your machine.
When it’s fully rebooted open Avast and
upgrade/configure it to your liking.

Installing Avast Antivirus Home Edition on PCLinuxOS
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Avast does not have to be installed on KDE4. It can
be installed on any other DE available with
PCLinuxOS. If you want to, you can scan the files
from the command line. Type in
avast ­­help
for more details and the command syntax.
Avast configuration files and viruses database are
stored in the ~/.avast folder.
If the menu entry was not created and you are
planning on creating your own launcher use:
avastgui
in the command box.
Icons are available here:
/usr/lib/avast4workstation/share/avast/icons/

If you follow this how­to and you get
E: Couldn't find package
avast4workstation­1.3.0­1. i586.rpm
error, then open Dolphin in your
/home/login directory. Go to View >
Show Hidden Files (make sure it’s
ticked),

Then, look for the file
.bashrc, and open it
with kwrite. Look for
this line:
alias su='su ­'
Put a comment in front of that line # so it looks
somewhat like this:
# alias su='su ­'
Save the file.
Reboot. Redo the howto from step one. It should
work without problem for you now.
Special thanks for this solution by Old­Polack.. It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Installing Avast Antivirus Home Edition on PCLinuxOS

http://www.pclinuxos.com
http://twitter.com/iluvpclinuxos
http://ge.tt/93lE3L8?c
http://ge.tt/9twFf7A?c
http://www.pclinuxos.com/forum/index.php/topic,101987.msg868565.html#msg868565
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by D. Moore (YouCanToo)

This how­to focuses on how to setup and configure
a ProFTPD server on your PCLinuxOS based
computer. The ProFTPD stands for “Professional
FTP Daemon”.

Installing ProFTPD on PCLinuxOS
Open the Synaptic Package Manager and do a
search for proftpd.

Mark it for installation.
NOTE: If you have any other ftpd service installed, it
will be removed.
Click apply, and then click apply again. Now
Synaptic will install ProFTPD. When finished click
"Close" and then close Synaptic.

How to configure ProFTPD
We need to edit the proftpd config file. In your
favorite text editor as the root user, open the
/etc/proftpd.conf file.
We need to change the following options.
We should change the ftp server display name.
ServerName "ProFTPD Default Installation"
Example:
ServerName "brainiac"
Make sure all ftp users are "jailed" within their own
directory. No snooping allowed!
#DefaultRoot ~
Uncomment this line and change to to read:
DefaultRoot ~
Now save your configuration file and exit your text
editor.

Our basic configuration is now complete
Now we need to start our proftpd service. In a
console window as root, enter the following
command:
service proftpd start
You should see something like this:

[root@laptop etc]# service proftpd startStarting proftpd [ OK ][root@laptop etc]#
If you see [ FAILED ], go back and double check your
work, and try again.
Congratulations if you got the "OK.” Your ftp server
is up and running.

Adding a new ftpuser
By default, the proftpd daemon reads the host's
/etc/passwd file for logging in users. This means that
to add FTP users, you simply need to create new
system accounts for those users in your /etc/passwd
file.
In a console window as root enter in the following
(all on one line):
adduser ­d/path/to/the/ftpuser/home/directory ­s
/usr/bin/bash ftpuser*
where *ftpuser is the ftpusers name.
­­­EXAMPLE: ­­­[root@laptop etc]# adduser ­d/home/mastermid ­s /usr/bin/bash mastermind[root@laptop etc]#
Setup a password for the ftpuser:
passwd ftpuser*
where *ftpuser is the name of the user.

Install & Configure ProFTPD On PCLinuxOS
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­­­ EXAMPLE: ­­­[root@laptop etc]# passwd mastermindChanging password for user mastermind.New password:Retype new password:passwd: all authentication tokens updatedsuccessfully.[root@laptop etc]#
NOTE: the password is not echoed to the screen.
That's it folks. Your new ftp server awaits your every
command.
For those using Webmin, you will need to download
and install the proftpd module. Log into your webmin
admin page and click on the "webmin" tab and then
select "Webmin Configuration."
In the main screen click on "Webmin Modules."
Now, mark the “Standard module from” and enter
proftpd. Then click the “Install Module” button.
Webmin will now download and install the ProFTPD
module for you.

Now in the left hand pane, click on the "Un­used"
Modules and then click on "ProFTPD Server"
Webmin will tell you that it can not be loaded, click
on "Module Config"
You will need to make the following changes to the
configuration.
Test config file after manual changes? Select
YES
Path to ProFTPD config file /etc/proftpd.conf
Path to ProFTPD executable /usr/sbin/proftpd
Path to ProFTPD PID file /usr/var/proftpd.pid
Now click on save and you should see the global
configuration GUI.

Install & Configure ProFTPD On PCLinuxOS
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If you did not make the changes to the ProFTPD
config file earlier in this HowTo, you can make them
by clicking on the "Edit Config Files" icon. You can
start and stop the ftp server by scrolling to the
bottom of the window and clicking on the "Start
Server" or "Stop Server" button.
For more detailed information about ProFTPD or
different ProFTPD server configurations, visit their
website at http://www.proftpd.org/.

Screenshot ShowcaseScreenshot Showcase

Posted by T6, June 3, 2012, running KDE4.

Install & Configure ProFTPD On PCLinuxOS

http://www.enkiconsulting.net/
http://www.pclinuxos.com/?page_id=213
http://www.proftpd.org/
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It's early in the morning from my bed I flop
And boot up my 'puter to see my desktop
Then my screen fills with color a beautiful blue
And Dobie the bull is waiting there too

It's late in the evening and I never stop
From gidgets to gadgets I hip and I hop
I look in the menu for all that is new
I never am lacking for something to do

It's fun to use Gimp my pictures to crop
Never out of space 'cause I have dear swap
Then on to Synaptic when I am through
To get all the updates oops I'm overdue

It's made by Texstar he is the top
Always is free I never had to shop
I go to the forum and meet all the crew
And for all their help I say a big thank you

It's early in the morning from my bed I flop
And boot up my 'puter to see my desktop
Then my screen fills with color a beautiful blue
And Dobie the bull is waiting there too

It's late in the evening and I never stop
From gidgets to gadgets I hip and I hop
I look in the menu for all that is new
I never am lacking for something to do

It's fun to use Gimp my pictures to crop
Never out of space 'cause I have dear swap
Then on to Synaptic when I am through
To get all the updates oops I'm overdue

It's made by Texstar he is the top
Always is free I never had to shop
I go to the forum and meet all the crew
And for all their help I say a big thank you

Tra­la­la tweedlee dee dee
Oh I have been blessed

With an OS that gives me such finesse
Tra­la­la tweedlee dee dee

I'm here to profess
I run the best system

It's PCLOS

ms_meme's Nook: Tra La La PCLOS

MP3 OGG

http://pclosmag.com/html/Issues/201207/files/tweedleepclos.mp3
http://pclosmag.com/html/Issues/201207/files/tweedleepclos.ogg
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by AndrzejL

Sometime ago I created a slideshow video from a
collection of wedding photos for a friendly couple. I
made DVD video with nice background music out of
it and gave it to them as an anniversary gift. I used
xsane/Imagination/mencoder/avidemux­
qt/devede/K3B to accomplish this – all of which are
available in PCLinuxOS repositories, just in case
you wondered. I wanted to keep a backup of this
DVD on my HDD in a ISO file format, just in case
they asked for another copy.

How would I create ISO file from a CD/DVD media?
Its VERY simple. Use the dd command. This is how
it’s done:
Assuming that:
A) Your system identifies the CD/DVD drive as
/dev/sr0.
B) Your destination folder is based in your home
folder.
C) The filename you want to use is file.iso.
Open a terminal and issue this command, followed
by [ENTER] key:
dd if=/dev/sr0 of=~/file.iso
Where:
if=/dev/sr0 means read from /dev/sr0 (raw format)
of=~/file.iso means copy the media to a file named
file.iso located in your /home/user/ folder i.e. backup
media to ISO image.
Now you can, for example:
A) Burn the ISO to a CD/DVD to make extra copies,
using K3B/Brasero/SimpleBurn, or any other optical
disc writing application.
B) If it’s, let’s say a Linux LiveCD, you can use ISO
to boot it in VirtualBox (also available in PCLinuxOS
repositories).
C) Do many other things with it.
I hope this helps.

Create ISO from a DVD or CD Drive

Connect connections in one
convenient location!

All your
PCLinuxOS

http://pclinuxoshelp.com/index.php/Main_Page
http://pclinuxos.com/?page_id=188
http://pclosmag.com/links.html
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Top: Posted by LKJ, June 11, 2012, running Gnome.
Bottom: Posted by GermanTux, June 3, 2012, running Xfce.

Top: Posted by Ramchu, June 9, 2012, running KDE4.
Bottom: Posted by Crow, June 18, 2012, running KDE4.

More Screenshot Showcase




